# CONTENT

<table>
<thead>
<tr>
<th>1. Abstract</th>
<th>5</th>
</tr>
</thead>
<tbody>
<tr>
<td>2. Specifications</td>
<td>6</td>
</tr>
<tr>
<td>3. Parts And Dimensions</td>
<td>8</td>
</tr>
<tr>
<td>3.1 NewCode Relay</td>
<td>8</td>
</tr>
<tr>
<td>3.2 Big amp C.T. &amp; Core Balance With 110 To 550V Converter</td>
<td>9</td>
</tr>
<tr>
<td>3.3 Small C.T. With 110 To 550V Converter</td>
<td>10</td>
</tr>
<tr>
<td>3.4 External Memory Module (FPR0407)</td>
<td>11</td>
</tr>
<tr>
<td>3.5 Connection Cable C.T. To Relay</td>
<td>12</td>
</tr>
<tr>
<td>3.6 NewCode Expanded I/O Module (FPR0412)</td>
<td>13</td>
</tr>
<tr>
<td>3.7 RTD Expansion 4 Channel Module (FPR0413)</td>
<td>14</td>
</tr>
<tr>
<td>3.8 NewCode MMI 420</td>
<td>15</td>
</tr>
<tr>
<td>3.9 NewCode 4 to 20mA, 2xIn and 2xOut (FPR0415)</td>
<td>16</td>
</tr>
<tr>
<td>3.10 1100 to 550 Voltage Converter (FPR0208)</td>
<td>17</td>
</tr>
<tr>
<td>3.11 Insulation Lockout (FPR0420)</td>
<td>18</td>
</tr>
<tr>
<td>3.12 RJ11 to RJ11 Cable (CAB0100)</td>
<td>18</td>
</tr>
<tr>
<td>3.13 RS232 to IrDA Cable (FPR0205)</td>
<td>19</td>
</tr>
<tr>
<td>3.14 Mini USB Cable (CAB0029)</td>
<td>20</td>
</tr>
<tr>
<td>3.15 USB to RS232 Converter</td>
<td>21</td>
</tr>
<tr>
<td>3.16 Completed System</td>
<td>22</td>
</tr>
<tr>
<td>4. Protection Features</td>
<td>23</td>
</tr>
<tr>
<td>4.1 Over Current (Overload) Detection</td>
<td>23</td>
</tr>
<tr>
<td>4.2 Undercurrent (Minimum load) Detection</td>
<td>24</td>
</tr>
<tr>
<td>4.3 Unbalance Phase Currents Detection</td>
<td>25</td>
</tr>
<tr>
<td>4.4 Single Phasing (Phase lost) Detection</td>
<td>25</td>
</tr>
<tr>
<td>4.5 Run-Stall Detection</td>
<td>26</td>
</tr>
<tr>
<td>4.6 Starts per Hour Control</td>
<td>27</td>
</tr>
<tr>
<td>4.7 Short Circuit Detection</td>
<td>27</td>
</tr>
<tr>
<td>4.8 Voltage Symmetry (Voltage Unbalance) Detection</td>
<td>28</td>
</tr>
<tr>
<td>4.9 Over and Under Voltage Detection</td>
<td>28</td>
</tr>
<tr>
<td>4.10 Voltage Phase Rotation</td>
<td>29</td>
</tr>
<tr>
<td>4.11 High or Low Frequency Detection</td>
<td>29</td>
</tr>
<tr>
<td>4.12 Insulation Failure Detection</td>
<td>30</td>
</tr>
<tr>
<td>4.13 Earth Leakage Detection (I_{EL} &lt; 2A)</td>
<td>30</td>
</tr>
<tr>
<td>4.14 Earth Fault Detection (I_{EL} ≥ 2A)</td>
<td>31</td>
</tr>
<tr>
<td>4.15 Fail Safe Selection</td>
<td>31</td>
</tr>
<tr>
<td>5. Logistical Data</td>
<td>32</td>
</tr>
<tr>
<td>5.1 Modal Information</td>
<td>32</td>
</tr>
<tr>
<td>5.2 Counters</td>
<td>32</td>
</tr>
<tr>
<td>5.3 Description</td>
<td>33</td>
</tr>
<tr>
<td>6. Control Logic</td>
<td>34</td>
</tr>
<tr>
<td>6.1 Field Inputs (Located On The NewCode Relay)</td>
<td>34</td>
</tr>
<tr>
<td>6.2 Logic Function 1 to 6</td>
<td>35</td>
</tr>
</tbody>
</table>
6.3 Timers A and B ........................................................................................................... 36
6.4 Counter A and B ......................................................................................................... 36
6.5 Start And Stop Timer .................................................................................................. 37
6.6 Comparator ................................................................................................................ 37
6.7 Latch A And B ............................................................................................................ 37
6.8 External Trip Reset ..................................................................................................... 38
6.9 Emergency Stop ......................................................................................................... 38
6.10 Pulse Generator ....................................................................................................... 39
6.11 Relay Outputs .......................................................................................................... 39
7. Starter Types .............................................................................................................. 40
   7.1 Protection Starter ..................................................................................................... 41
   7.2 Starter Control Location Selection ........................................................................ 42
   7.3 Feedback Signal ..................................................................................................... 43
   7.4 Starter Input Signals ............................................................................................... 44
   7.5 Starter Timers ......................................................................................................... 45
   7.6 Direct On Line Starter ............................................................................................ 47
   7.7 Direct On Line Reversal Starter ............................................................................. 49
   7.8 Star Delta Starter .................................................................................................... 51
   7.9 Star Delta Reversal Starter ..................................................................................... 53
   7.10 Dahlander Starter ................................................................................................. 55
   7.11 Dahlander Reversal Starter .................................................................................. 57
   7.12 Pole-Changing Starter ......................................................................................... 59
   7.13 Pole-Changing Reversal Starter .......................................................................... 61
   7.14 Soft Starter ........................................................................................................... 63
   7.15 Soft Starter Reversal ............................................................................................ 65
   7.16 Oil Circuit Breaker Direct Online Starter ............................................................. 67
8. NewCode History Log .................................................................................................. 69
   8.1 Real Time Clock ...................................................................................................... 69
   8.1 Fault Record ........................................................................................................... 69
   8.2 Event Record .......................................................................................................... 70
9. Module Configurations ............................................................................................... 71
   9.1 CT Modules ............................................................................................................ 71
   9.2 1100 to 550 Voltage Converter (FPR0208) ......................................................... 72
   9.3 Insulation Lockout (FPR0420) .............................................................................. 72
   9.4 NewCode Expanded I/O Module (FPR0412) ......................................................... 73
   9.5 RTD Expansion 4 Channel Module (FPR0413) ..................................................... 74
   9.6 NewCode 4 to 20mA, 2xIn and 2xOut (FPR0415) ................................................. 75
   9.7 NewCode MMI 420 ................................................................................................. 76
   9.8 External Memory Module (FPR0407) ................................................................... 76
10. Software Configuration Tool (Front end) ................................................................. 77
   10.1 System Requirement ............................................................................................ 77
   10.2 Installing Software ............................................................................................... 77
   10.3 Installing NewCode USB Drivers ......................................................................... 78
   10.4 Connecting The Front End To The NewCode.................................................... 79
   10.5 Upload Settings .................................................................................................... 79
   10.6 Download Settings ............................................................................................... 80
1. Abstract

The NewCode Relay is an ISO 9001:2000 compliant, local designed and manufactured three phase motor protection relay. It is a micro-controller based precision instrument with protection, advanced control features and starter logic. The relay is designed to cater for the low voltage motor protection market and is available in different current models. The current transformers, including the core balance current transformers are external.

The relay is fully configurable with the aid of front-end software or a man machine interface unit (MMI). Event records can also be downloaded with the aid of the MMI onto a memory stick for further analysis. All the settings are password protected. The relay has an on board database where time and date stamped records are kept. Two types of records are kept namely fault records (35 last faults) and event records (1400 events). In the case of event records, the user has limited access rights (read only). The front-end also has a data recorder and a spectrum analyzer, which could be used to analyze motor performance and supplied power quality respectively. The spectrum analyzer can detect harmonics up to the 9th harmonic on any of the three phase currents.

The relay detects earth leakage currents with the aid of the external core balance current- transformer and is configurable to operate in inverse definite minimum time (IDMT) or instantaneous definite time (IDT) mode.

A unique feature is added to the relay in the form of simulation. This function could be used for personnel training or relay functionality testing.
# 2. Specifications

<table>
<thead>
<tr>
<th>General Data</th>
<th>Dimensions</th>
<th>• 45 (W) mm x 99 mm (H) x 112.75 mm (D)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auxiliary supply</td>
<td>• 85 Vac/dc ~ 264 Vac/dc 50Hz / 60Hz</td>
<td></td>
</tr>
<tr>
<td>Mounting</td>
<td>• Din rail clip</td>
<td></td>
</tr>
</tbody>
</table>

**Field Inputs**

| Amount                     | • 7 common field inputs.                      |
| Input Voltage Range        | • 24Vac/dc to 220Vac/dc                       |

**Outputs**

| Amount                     | • 4 x normally open and close relays         |
| Rating                     | • 6 Amps at 250Vac                            |
|                            | • 6 Amps at 30 Vdc                            |

| CT modal range             |                                                                                       |
| NC 001 (FPR0403)          | • 0.01 Amp to 10 Amp                                                                 |
|                            | • MLC 10%, 100% load 0.1 Amp                                                            |
|                            | • MLC 100%, 100% load 1 Amp                                                            |
| NC 005 (FPR0403)          | • 0.05 Amp to 50 Amp                                                                 |
|                            | • MLC 10%, 100% load 0.5 Amp                                                            |
|                            | • MLC 100%, 100% load 5 Amp                                                             |
| NC 025 (FPR0403)          | • 0.25 Amp to 250 Amp                                                                  |
|                            | • MLC 10%, 100% load 2.5 Amp                                                            |
|                            | • MLC 100%, 100% load 25 Amp                                                           |
| NC 050 (FPR0403)          | • 0.50 Amp to 500 Amp                                                                  |
|                            | • MLC 10%, 100% load 5 Amp                                                             |
|                            | • MLC 100%, 100% load 50 Amp                                                           |
| NC 100 (FPR0403)          | • 1.00 Amp to 1000 Amp                                                                 |
|                            | • MLC 10%, 100% load 10 Amp                                                            |
|                            | • MLC 100%, 100% load 100 Amp                                                          |
| NC 300 (FPR0403)          | • 3.00 Amp to 3000 Amp                                                                  |
|                            | • MLC 10%, 100% load 30 Amp                                                            |
|                            | • MLC 100%, 100% load 300 Amp                                                          |

**External CT**

- MLC 10%, 10% load 300 Amp
- MLC 100%, 100% load 300 Amp
- External current transformer can be added.
- XXX:5 or XXX:1 or existing CT’s can be used.

<p>| Current range              | • 0% to 1000% In                           |
| Resolution                 | • 2%                                      |
| Line Voltage on CT’s       |                                          |
| Direct Measurement         | • 110Vac to 550Vac Line                   |
| Converter (FPR0208) Plugged Into CT Block. | • 680 Vac to 1100Vac Line               |
| Voltage Transformer        | • 3K3Vac to 110Vac Line                   |
|                            | • 6K6Vac to 110Vac Line                   |
|                            | • 11K0Vac to 110Vac Line                  |
| Earth leakage              |                                         |
| CBCT in NC100 and 300 Fault Level | • 0.03 Amps to 3 Amps                   |
| External core that can be used | • 57mm ID core.                           |
|                            | • 63mm ID core.                           |
|                            | • 104mm ID core.                          |
|                            | • 150mm ID core.                          |
| Insulation lockout         | Ohm reading                               |
|                            | • 1 to 199 kOhm.                          |
|                            | Incremental                               |
|                            | • 1 kOhm.                                 |</p>
<table>
<thead>
<tr>
<th>Communication interfaces</th>
<th>USB</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• Interface to PC.</td>
<td></td>
</tr>
<tr>
<td>IrDA</td>
<td>• IrDA cable needed to communicate.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Baud rate 19200 kbs.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Distance 0.5 meter.</td>
<td></td>
</tr>
<tr>
<td>SCADA</td>
<td>• Profibus.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>o GSD : NEWEF880.gsd</td>
<td></td>
</tr>
<tr>
<td></td>
<td>o GSD : NEWEF877.gsd</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• CANbus.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Modbus-RTU.</td>
<td></td>
</tr>
</tbody>
</table>
3. Parts And Dimensions

3.1 NewCode Relay

- FPR0400 – With Profibus.
- FPR0418 – With Modbus.
- FPR0419 – With Canbus.
3.2 Big amp C.T. & Core Balance With 110 To 550V Converter

- FPR0402 – 10 to 100 Amps.
- FPR0401 – 30 to 300 Amps.
3.3 Small C.T. With 110 To 550V Converter

- FPR0403 – 0.1 to 1 Amp.
- FPR0404 – 0.5 to 5 Amp.
- FPR0405 – 0.25 to 25 Amp.
- FPR0406 – 5 to 50 Amp.
3.4 External Memory Module (FPR0407)
3.5 Connection Cable C.T. To Relay

- FPR0408 – 1000mm cable length.
- FPR0409 – 500mm cable length.
- FPR0410 – 300mm cable length.
- FPR0411 – 100mm cable length.
3.6 NewCode Expanded I/O Module (FPR0412)
3.7 RTD Expansion 4 Channel Module (FPR0413)
3.8 NewCode MMI 420

- FPR0414 – No remote buttons.
- FPR0432 – With remote buttons.
3.9 NewCode 4 to 20mA, 2xIn and 2xOut (FPR0415)
3.10 1100 to 550 Voltage Converter (FPR0208)

Wires are 1000mm in length.
3.11 Insulation Lockout (FPR0420)

See voltage converter drawing in chapter 3.10 except one brown wire coming from the top instead of red, white and blue. Wires are 500mm in length.

3.12 RJ11 to RJ11 Cable (CAB0100)

Cable is 1000mm in length.
3.13 RS232 to IrDA Cable (FPR0205)

Cable is 1000mm in length.
3.14 Mini USB Cable (CAB0029)

Cable is 1500mm in length.
3.15 USB to RS232 Converter

Cable is 150mm in length.
3.16 Completed System
4. Protection Features

4.1 Over Current (Overload) Detection

- IEC 60255-8 specification.
- Curve class settings: 3 seconds to 40 seconds.
- Motor full load setting (MLC): 10% to 100% of CT modal setting.
- Example NC 5 = 5 amp CT.
  - 10% = 0.5 amps. I level will read 100% at 0.5 amps.
  - 100% = 5 amps. I level will then read 100% at 5 amps.
- Resetting a thermal trip.
  - When the thermal capacity is below the thermal reset level the relay can be reset.
  - Reset can be set to manual reset or auto reset.
  - After the third auto reset the NewCode will require a manual reset.
  - A flashing overload LED will indicate that the NewCode will reset when the thermal curve is below the reset threshold.
- Reset threshold.
  - Adjustable range of 30% to 90%.
  - Dynamic threshold adjustment determined over 10 last restarts.
- Trips caused with a thermal trip will have to wait for the thermal capacity to cool down before starting the application.
- This feature cannot be disabled.
- Typical applications.
  - All applications.
  - Thermal is used to protect the windings of the motor with the I^2T curve.

<table>
<thead>
<tr>
<th>High Speed Motor Setting</th>
<th>Low Speed Motor Setting</th>
<th>Thermal Capacity (Used)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Motor Full Load Setting</td>
<td>60 %</td>
<td>Actual Level Adjust</td>
</tr>
<tr>
<td>Thermal Curve Class Selector</td>
<td>10 sec</td>
<td>0 %</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Reset Threshold Level</td>
</tr>
<tr>
<td></td>
<td></td>
<td>70 %</td>
</tr>
</tbody>
</table>

- Fail-Safe Select
- Auto Thermal Reset Select
- Vacuum fail
- Dynamic TC Rst THold Adj Select
- Starts per Hour Select
4.2 Undercurrent (Minimum load) Detection

- Trip level adjustment for under current and power factor: 10% to 100%
- Under current trip type.
  - Under current.
    - Will activate when the “in service” flag is active and the start-up delay time ran out.
  - Power factor.
    - Power level will be used to arm the trip.
    - In the event if line voltage goes to 0V the minimum load will use the load level to trip on undercurrent.
- Selection: Current level or power factor %
- Trip delay time: 1 to 10 seconds
- Start-up delay: 1 to 200 seconds (To facilitate pump priming)
- Reset time options.
  - 10 seconds.
  - 5 minutes.
  - 10 minutes.
  - 20 minutes.
  - 30 minutes.
  - 45 minutes.
  - 1 hour.
  - 3 hours.
  - 6 hours.
- Feature selectable.
- Typical applications.
  - Pumps.
  - Detect if a pump is running dry.
  - Section that is not allowed to run a light load.
4.3 Unbalance Phase Currents Detection

- Trip level adjustment: 0 to 50%.
- Trip delay time: 1 to 10 seconds.
- Feature selectable.
- Typical applications.
  - All applications.

<table>
<thead>
<tr>
<th>Unbalance Phase Current</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trip Delay 10 sec</td>
</tr>
<tr>
<td>Trip Level 20 %</td>
</tr>
</tbody>
</table>

4.4 Single Phasing (Phase lost) Detection

- Trip delay time: 1 second fixed.
- Feature selectable.
- Typical applications.
  - All applications.
  - Protects the transformer and motor when one phase becomes disconnected.
4.5 Run-Stall Detection

- Stall current trip level adjustment: 110% to 300%.
- Stall trip delay time: 0 to 120 seconds adjustable.
  - Allows the drive to clear the line before arming the running stall.
- Stall trip delay time: 100 to 2000 milliseconds.
- Feature selectable.
- Typical applications.
  - Crushers.
  - Conveyers.
  - Miller.
  - Jet or normal fans.
  - Any drive that must be protected against mechanical jam.

<table>
<thead>
<tr>
<th>Run-Stall</th>
<th>Trip Level</th>
<th>Trip Delay</th>
<th>Trip Holdoff Delay</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>300 %</td>
<td>2000 ms</td>
<td>10 sec</td>
</tr>
</tbody>
</table>

4.5 Vectorial-Stall Detection

- Trip: Static or decreasing power factor.
- Trip delay: 33% of curve class setting.
- Feature selectable.
- Typical applications.
  - Fans.

Vectorial Stall Select
4.6 Starts per Hour Control

- Starts setting: 1 to 60 starts adjustable.
- Consecutive starts: 1 to 3 starts per interval adjustable.
- Reset: Automatic.
- Feature selectable.
- Typical applications.
  - All drives that require a limited amount of starts.

<table>
<thead>
<tr>
<th>Start Count</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Starts per hour allowed</td>
<td>6</td>
</tr>
<tr>
<td>Number of consecutive starts</td>
<td>3</td>
</tr>
</tbody>
</table>

4.7 Short Circuit Detection

- Articulated detection:
  - \( I_{LOAD} > 950\% \) and Power factor < 85% or
  - \( I_{LOAD} > 300\% \) and Power factor > 85%.
- Trip delay time: 1 second fixed.
- Feature selectable.
  - All applications were the drives cable is exposed to damage.
  - No shunts installed.
  - Feeder panels.
  - Fitting panels.
4.8 Voltage Symmetry (Voltage Unbalance) Detection
- Trip delay time: 10 seconds fixed.
- Trip level adjustment: 70% to 99%.
- Feature selectable.
- Typical applications.
  - Any critical transformers that need to be protected.
  - Feeder panels.
  - Fitting panels.

4.9 Over and Under Voltage Detection
- Trip delay time: 10 seconds fixed.
- Trip level adjustment: 0% to 25% of selected line voltage.
- Line voltage selection.
  - 110 Volts (Direct measurement).
  - 380 Volts (Direct measurement).
  - 400 Volts (Direct measurement).
  - 525 Volts (Direct measurement).
  - 550 Volts (Direct measurement).
  - 680 Volts (1100 Volt to 525 Volt converter).
  - 950 Volts (1100 Volt to 525 Volt converter).
  - 1100 Volts (1100 Volt to 525 Volt converter).
  - 3300 Volts (3300 Volt to 110 Volt transformer).
  - 6600 Volts (6600 Volt to 110 Volt transformer).
  - 11000 Volts (11000 Volt to 110 Volt transformer).
- Trip level: Factory settings.
- Feature selectable.
- Typical applications.
  - Areas with unstable power source.
  - High lightning strikes.
4.10 Voltage Phase Rotation

- No trip delay time.
- Auto reset once fault is fixed.
- Voltage rotation direction.
  - Forward.
  - Reverse.
- Feature selectable.
- Typical applications.
  - Drives that can only move in one direction and the source supply is pluggable.
  - Fitting panels.
  - Feeder panels.
  - Pumps.

4.11 High or Low Frequency Detection

- Trip delay time: 10 seconds fixed.
- Trip level:
  - 45Hz to 55Hz for 50Hz system.
  - 55Hz to 65Hz for 60Hz system.
- Feature selectable.
- Typical applications.
  - Unstable supply source.
4.12 Insulation Failure Detection

- Detection is only achieved when no load is present.
- Insulation failure detects when one of the phases is short to earth.
- Insulation lockout (FPR0420) must be wired for insulation feature to work.
- Trip delay time: 1 second fixed.
- Trip level: 20 kOhm.
- Feature selectable.
- Typical applications.
  - EP panels.
  - Fitting panels.
  - Feeder panels.
  - Submergible pumps.
  - Detect when a cable is damaged.
  - Detect if a cable is being cut. (Cable theft)

4.13 Earth Leakage Detection \((I_{EL} < 2A)\)

- Earth leakage trip time selections.
  - Instantaneous Definite Time (INST) or
  - Inverse Definite Minimum Time (IDMT).
- Instantaneous Definite Time.
  - \(100 \text{ ms} \leq t \leq 1000 \text{ ms} \) at 50 ms steps.
- Inverse Define Minimum Time.
  - \(t \geq 130 \text{ ms} \).
- Harmonic filtering built into circuit.
- Trip level: 30mA to 999mA.
- Feature selectable.
- Typical applications.
  - Any application without earth leakage protection.
3.14 Earth Fault Detection (I_{EL} ≥2A)
- Harmonic filtering built into circuit.
- Trip delay time: 1 second fixed.
- Trip level: 2A fixed.
- Feature selectable.
- Typical applications.
  - Any application without earth leakage protection.

4.15 Fail Safe Selection
- Trip delay time: As soon as auxiliary supply is lost.
- Reset: Power up relay.
- Feature selectable.
- Typical applications.
  - Application that requires if auxiliary power is lost to the NewCode that the panel stops the drive.
5. Logistical Data

5.1 Modal Information

- NewCode modal and ratio setting allows the NewCode to calculate kVah and kWh.
  - Counts will go to a maximum of 65535.
- Frontend will also be able to display amps and kVa and kW correctly.
- NewCode relay does not calculate KVa and kW.
- SCADA can use the MLC, CT model and CT ratio to calculate kVa and kW.
  - \[ I = \left(\frac{(NC \text{ model} \times (MLC / 100)) \times I_L}{100}\right) \times \text{CT ratio}. \]
  - \[ kVa = \left(3 \times V_{\text{phase}} \times I\right) / 1000. \]
  - \[ kW = (kVa \times P_{\text{LEVEL}}) / 100. \]

5.2 Counters

- Startup counter is the amount of starts that the motor executed.
  - Starts are counted with actual load and not the start command.
- Trip counter is amount of trips that occurred.
- Total motor running hours is the amount of hours load was detected.
- Total motor running hours at load is the amount of hours the load level was above 50%.
- Drive available hours is the amount of hours the panel was on.
- All counters will count to a maximum of 65535.
5.3 Description

- Description of the drive that the NewCode is protecting.

<table>
<thead>
<tr>
<th>Unique Drive ID</th>
<th>Description of drive unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>FLT PUMP</td>
<td>FLT-PMP01-525</td>
</tr>
</tbody>
</table>
6. Control Logic

6.1 Field Inputs (Located On The NewCode Relay)

- Field input on delay range: 0 to 2000 milliseconds with a 50 millisecond incremental.
- Allows the field input to settle before switching the input on or high.
- Off or low will be instantaneous as soon as the input is off or low.
- Typical applications.
  - Level floating switch.
  - Spring maximum or minimum position indication.

![Digital Field Input Delays Table]

<table>
<thead>
<tr>
<th>Input 1</th>
<th>500 ms</th>
<th>Input 5</th>
<th>500 ms</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input 2</td>
<td>500 ms</td>
<td>Input 6</td>
<td>500 ms</td>
</tr>
<tr>
<td>Input 3</td>
<td>500 ms</td>
<td>Input 7</td>
<td>500 ms</td>
</tr>
<tr>
<td>Input 4</td>
<td>500 ms</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
6.2 Logic Function 1 to 6

- Signal condition lookup table.
- Rows are “AND” logic and columns are “OR” logic.
  - Example:

  - Inputs must be 001 or 100 for the output to be 1.
    - Digital field input 1 or 5 must be on to output on.
    - If digital input 1 and 5 are on then the output will be off.
    - Input B must always be low.
    - \((A\cdot b\cdot c) + (a\cdot b\cdot C) = \text{Output}\).
6.3 Timers A and B

- Start input is level triggered.
- Reset input is level triggered.
  - Reset will take the output from high to low.
- Time can be set from 0 to 30000 seconds.
- Two types of outputs will be generated.
  - Bi-stable will turn the output high when the timer expired and the start input is high.
  - Mono stable will turn the output high when the start input goes high but when the timer expires then the output will go low.

6.4 Counter A and B

- Count up input is positive edge triggered which will let the counter count up.
  - Even when the value is above the trip counter setting, the counter value will still count up till 250.
- Count down input is positive edge triggered.
  - Count down input will count the counter value down till the value reaches 0.
- Reset input is positive edge triggered and will reset the counter value to 0.
- Trip counter setting can be set from 1 to 250.
6.5 Start And Stop Timer

- Compares the time against the NewCode real time clock.
- Will switch the output on when the real time clock is equal to the start time.
- Will switch the output off when the real time clock is equal to the stop time.
- This can work to start and stop a drive in a certain time range.

6.6 Comparator

- Will compare the thermal capacity used to the set level.
- Output will be off when the thermal capacity used is below the comparator set level.
- Output will be on when the thermal capacity is above the comparator set level.

6.7 Latch A And B

- Set input is positive edge triggered.
  - Will set the latch on when the set input goes on.
  - Even when the set input goes off the output will stay on as if the set input was still on.
  - Latch will not set the output high after a power cycle, as the latch is non-volatile.
- Reset input is positive edge triggered.
  - Will turn the output off.
6.8 External Trip Reset

- Input is positive edge triggered.
- Used to reset a fault with aid of a digital input, function or SCADA bit.

6.9 Emergency Stop

- Input is negative level triggered.
- An emergency stop will get recorded to the event record as soon as the input goes low.

Do not use this input as an emergency stop but as an indication that the emergency stop was pressed. Always wire the emergency stop as according to the safety standards.
6.10 Pulse Generator

- Generates a pulse at a set frequency rate.
- Control is the source input that will activate the pulse generator.
- Period is the width of the pulse on and off.
  - Can be set from 1 to 240 minutes.
- Duty cycle sets the percentage of the period that the pulse must be on.
  - Can be set from 1 to 100 present.

6.11 Relay Outputs

- Relay 2, 3 and 4 outputs are fully configurable.
- Profibus will use relay 2 and 3 if the GSD file “NEWEF877.gsd” is selected.
  - This is to make the NewCode look like a MA-Relay connected to the Profibus PLC master.
- Relay 1 has two configurations in the “Settings” tab.
  - Dedicated trip relay to trip on faults.
  - Configurable relay makes the relay assignable to any flag.
- NewCode set in protection and starter mode output flags differ for the relays output.
7. Starter Types

- Following starter type options are available on the NewCode.
  - Protection.
  - Direct on line.
  - Direct on line reversal.
  - Star delta.
  - Star delta reversal.
  - Dahlander.
  - Dahlander reversal.
  - Pole-changing.
  - Pole-changing reversal.
  - Soft starter.
  - Soft starter reversal.
  - Oil circuit breaker direct online.
7.1 Protection Starter

- Starter panel is disabled.
- Relay outputs are only available under the “Control Logic” tab of the frontend.
- Relay outputs are configurable to the logic flags.
- ESTOP will trip the main relay when the ESTOP is configured.
  - One will disable the ESTOP.
  - Assign an unauthorized current time will behave like a starter and trip on unauthorized current.
  - A digital input can also be used to indicate unauthorized current.
7.2 Starter Control Location Selection

- The starter control inputs can come from 4 sources.
  - Local.
  - Remote.
  - PLC.
  - Operating panel.

7.3 Feedback Signal

- Determines if the drive is running.
- Feedback signal can be assigned to a digital input for feeder panels that do not draw load when the contactor is energized to prevent a feedback fault due to no load.
- Feedback fault is when the motor was indicating feedback but then the load or input signal falls away.
- This will trip the NewCode on feedback fault.
- Feedback fault can be set from 100 to 2000 milliseconds delay.
7.4 Starter Input Signals

Inputs listed above are the inputs that will give the starter logic commands to start and stop the drive. Some of the inputs do not get used in certain starters.

Local panel is the buttons that normally are located on the panel door.

Remote is field type buttons.

Auto is usually SCADA bits assigned from the SCADA cyclic in bytes.

- **Start >>**
  - Primary forward start of any starter block.
- **Start >**
  - Secondary start.
  - Not used by all the starter blocks.
  - Mostly used on two speed type drives.
- **Start <<**
  - Primary reverse start.
  - Mostly used by forward and reverse drives like a conveyer system.
- **Start <**
  - Secondary reverse start.
  - Mostly used by forward and reverse drives with two-speed capability.
- **Stop**
  - Stop will stop the drive.
- All the stops are linked. If one stop falls away and even if that control is not selected it will stop the drive.
- Example: Auto is selected but the local stop goes low the drive will be stopped.
- This is to keep all stops active.
- Stop signal must be active high.

**Interlock**
- Interlock is to lock out the motor or indicate that the drive is ready to start.
- Unlike the stop the signal selection must be for that interlock.
- Interlocks signal must be active high.

### 7.5 Starter Timers

A couple of starter timers have been added to help with starting features.

![Starter Timer Settings](image)

- **Pre start warning.**
  - Time that it will take to blow a siren or flash lights before starting the motor.
  - Allows staff to stand clear of the line that is going to start.
  - Pre start warning time: 0 to 999 seconds.
- **Execution**
  - From the time that the start command was given till the drive runs is the execution time.
  - In the event that the feedback signal does not go high before the starter timer time outs.
  - The NewCode will then trip on execution fault due to that the feedback signal did not go high.
  - Execution time: 0 to 10 seconds.
- **Feedback**
  - Must always remain high after a start.
- Will prevent the NewCode stopping the drive due to a fast power dib on the feedback signal.
  - Feedback time: 0 to 2000 milliseconds at 50 millisecond increment.

- Backspin
  - In a pump application you might find liquid flowing back after the drive stopped.
  - Best is to wait for the water to flow back and then to start the motor.
  - Backspin timer will prevent the drive from starting till the backspin timer has timed out.
  - Backspin time: 0 to 999 seconds.

- DC braking
  - Some drives allow to be stopped with aid of injecting a DC signal to stop the rotor.
  - DC brake can be setup to energize the DC signal and then to remove the DC signal.
  - Warning DC voltage on the drive could damage windings if injected to long.
  - DC braking: 0 to 2000 milliseconds at 50 milliseconds increment.

- Restart
  - When the panel lost supply for a short time it is possible to restart the drive automatically.
  - After the power dip the NewCode will wait for the restart time period and restart the motor.
  - Restart: 0 to 600 seconds. 0 Disables the restart time.

- Start maximum
  - Star delta configuration starts up with star first, and then changes over to delta.
  - This is done in two ways:
    - When the drive starts in star and the load drops below 90% then the NewCode will change over to the delta network.
    - If the drive does not fall below 90% after the star times out then the NewCode will change over.
  - Star maximum: 1 to 50 seconds.

- Transition
  - In application were a two speed drive is used you need a delay to switch from high speed to low speed.
  - This is to prevent the shaft from twisting.
  - Transition: 0 to 2000 milliseconds at 50 milliseconds increment.

- Unauthorised current
  - In event were the contactor gets forced in and starts the drive the system should trip the shunt.
  - Unauthorised current will trip the shunt breaker in the event that the main contactor is forced or frozen.
  - Unauthorised current: 0 to 2000 milliseconds at 50 milliseconds increment.
  - 0 will disable unauthorised current.
7.6 Direct On Line Starter

DOL is one of the most basic starter types found. In a circuit a main contactor and shunt is found connected in series with the motor as shown in the drawing below:

Following inputs become available:

<table>
<thead>
<tr>
<th>Inputs</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start &gt;&gt;</td>
<td>Starts the drive.</td>
</tr>
</tbody>
</table>

Following outputs become available:

<table>
<thead>
<tr>
<th>Outputs</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Starter output 1</td>
<td>Main contactor controller.</td>
</tr>
</tbody>
</table>
7.7 Direct On Line Reversal Starter

DOL reversal is a basic forward and reverse starter type. In a circuit a main contactor could be found with a forward and reverse contactor and shunt is found connected in series with the motor as shown in the drawing below:

Following inputs become available:

<table>
<thead>
<tr>
<th>Inputs</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start &gt;&gt;</td>
<td>Starts the drive in the forward direction.</td>
</tr>
<tr>
<td>Start &lt;&lt;</td>
<td>Starts the drive in the reverse direction.</td>
</tr>
</tbody>
</table>

Following outputs become available:

<table>
<thead>
<tr>
<th>Outputs</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Starter output 1</td>
<td>Main contactor controller.</td>
</tr>
<tr>
<td>Starter output 2</td>
<td>Forward contactor controller.</td>
</tr>
<tr>
<td>Starter output 3</td>
<td>Reverse contactor controller.</td>
</tr>
</tbody>
</table>
7.8 Star Delta Starter

Star delta takes the motor into two stages. First stage is the star phase to get the drive going. As soon as the load goes below 90% the NewCode will switch the drive into delta. See drawing below for a typical star delta configuration:

Following inputs become available:

<table>
<thead>
<tr>
<th>Inputs</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start &gt;&gt;</td>
<td>Starts the drive.</td>
</tr>
</tbody>
</table>

Following outputs become available:

<table>
<thead>
<tr>
<th>Outputs</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Starter output 1</td>
<td>Main contactor controller.</td>
</tr>
<tr>
<td>Starter output 2</td>
<td>Star contactor controller.</td>
</tr>
<tr>
<td>Starter output 3</td>
<td>Delta contactor controller.</td>
</tr>
</tbody>
</table>
7.9 Star Delta Reversal Starter

Star delta reversal takes the motor into two stages. First stage is the star phase to get the drive going. As soon as the load goes below 90% the NewCode will switch the drive into delta. The sequence is done for forward and reverse. See drawing below for a typical star delta reversal configuration:

Following inputs become available:

<table>
<thead>
<tr>
<th>Inputs</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start &gt;&gt;</td>
<td>Starts the drive in the forward direction.</td>
</tr>
<tr>
<td>Start &lt;&lt;</td>
<td>Starts the drive in the reverse direction.</td>
</tr>
</tbody>
</table>

Following outputs become available:

<table>
<thead>
<tr>
<th>Outputs</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Starter output 1</td>
<td>Forward contactor controller.</td>
</tr>
<tr>
<td>Starter output 2</td>
<td>Reverse contactor controller.</td>
</tr>
<tr>
<td>Starter output 3</td>
<td>Star contactor controller.</td>
</tr>
<tr>
<td>Starter output 4</td>
<td>Delta contactor controller.</td>
</tr>
</tbody>
</table>
7.10 Dahlander Starter

Designed for a pole changing motor with fast and slow poles. NewCode motor starter logic caters for the controlling the star and delta contactor for the Dahlander motor. See drawing below for a typical Dahlander configuration:

Following inputs become available:

<table>
<thead>
<tr>
<th>Inputs</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start &gt;&gt;</td>
<td>Starts the drive high speed.</td>
</tr>
<tr>
<td>Start &gt;</td>
<td>Starts the drive low speed.</td>
</tr>
</tbody>
</table>

Following outputs become available:

<table>
<thead>
<tr>
<th>Outputs</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Starter output 1</td>
<td>High speed contactor controller.</td>
</tr>
<tr>
<td>Starter output 2</td>
<td>Low speed contactor controller.</td>
</tr>
<tr>
<td>Starter output 3</td>
<td>High speed star contactor controller.</td>
</tr>
</tbody>
</table>
7.11 Dahlander Reversal Starter

Designed for a pole changing motor with fast and slow poles. NewCode motor starter logic caters for the controlling the star and delta contactor for the Dahlander motor. The star and delta contactor control is also done for reversal. See drawing below for a typical Dahlander reversal configuration:

Following inputs become available:

<table>
<thead>
<tr>
<th>Inputs</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start &gt;&gt;</td>
<td>Starts the drive high speed forward.</td>
</tr>
<tr>
<td>Start &gt;</td>
<td>Starts the drive low speed forward.</td>
</tr>
<tr>
<td>Start &lt;&lt;</td>
<td>Starts the drive high speed reverse.</td>
</tr>
<tr>
<td>Start &lt;</td>
<td>Starts the drive low speed reverse.</td>
</tr>
</tbody>
</table>

Following outputs become available:

<table>
<thead>
<tr>
<th>Outputs</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Starter output 1</td>
<td>High speed forward contactor controller.</td>
</tr>
<tr>
<td>Starter output 2</td>
<td>Low speed forward contactor controller.</td>
</tr>
<tr>
<td>Starter output 3</td>
<td>High speed forward or reverse star contactor controller.</td>
</tr>
<tr>
<td>Starter output 4</td>
<td>Low speed reverse contactor controller.</td>
</tr>
<tr>
<td>Starter output 5</td>
<td>High speed reverse contactor controller.</td>
</tr>
</tbody>
</table>
7.12 Pole-Changing Starter

Designed for a pole changing motor. Added to the starter logic under the “Settings” tab there will be two different MLC’s. One MLC is for high speed and the other is for the low speed. See drawing below for a typical pole-changing configuration:

Following inputs become available:

<table>
<thead>
<tr>
<th>Inputs</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start &gt;&gt;</td>
<td>Starts the drive high speed.</td>
</tr>
<tr>
<td>Start &gt;</td>
<td>Starts the drive low speed.</td>
</tr>
</tbody>
</table>

Following outputs become available:

<table>
<thead>
<tr>
<th>Outputs</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Starter output 1</td>
<td>High speed contactor controller.</td>
</tr>
<tr>
<td>Starter output 2</td>
<td>Low speed contactor controller.</td>
</tr>
</tbody>
</table>
### 7.13 Pole-Changing Reversal Starter

Designed for a pole changing motor. Added to the starter logic under the “Settings” tab there will be two different MLC settings. One MLC is for high speed and the other is for the low speed. All feature apply to the reverse as well. See drawing below for a typical pole changing reversal configuration:

Following inputs become available:

<table>
<thead>
<tr>
<th>Inputs</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start &gt;&gt;</td>
<td>Starts the drive high speed.</td>
</tr>
<tr>
<td>Start &gt;</td>
<td>Starts the drive low speed.</td>
</tr>
<tr>
<td>Start &gt;&gt;</td>
<td>Starts the drive forward high speed.</td>
</tr>
<tr>
<td>Start &gt;</td>
<td>Starts the drive forward low speed.</td>
</tr>
<tr>
<td>Start &lt;&lt;</td>
<td>Starts the drive reverse high speed.</td>
</tr>
<tr>
<td>Start &lt;</td>
<td>Starts the drive reverse low speed.</td>
</tr>
</tbody>
</table>

Following outputs become available:

<table>
<thead>
<tr>
<th>Outputs</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Starter output 1</td>
<td>High speed forward contactor controller.</td>
</tr>
<tr>
<td>Starter output 2</td>
<td>Low speed forward contactor controller.</td>
</tr>
<tr>
<td>Starter output 3</td>
<td>High speed reverse contactor controller.</td>
</tr>
<tr>
<td>Starter output 4</td>
<td>Low speed reverse contactor controller.</td>
</tr>
</tbody>
</table>
### 7.14 Soft Starter

Soft starter configuration works with a soft starter. But the start stop should be setup as a latch type input on the soft starter. Please see the soft starter used manual for reference to configure the remote start as a latch type start. Starter output 1 can also be used to drive a contactor that feeds into the soft starter. See drawing below for a typical soft starter configuration:

Following inputs become available:

<table>
<thead>
<tr>
<th>Inputs</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start &gt;&gt;</td>
<td>Start command.</td>
</tr>
</tbody>
</table>

Following outputs become available:

<table>
<thead>
<tr>
<th>Outputs</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Starter output 1</td>
<td>Main contactor in series with the soft starter.</td>
</tr>
<tr>
<td>Starter output 3</td>
<td>Remote reset pulse for the soft starter.</td>
</tr>
<tr>
<td>Starter output 4</td>
<td>Remote start output to the soft starter start input.</td>
</tr>
</tbody>
</table>
### 7.15 Soft Starter Reversal

Soft starter configuration works with a soft starter. But the start stop should be setup as a latch type input on the soft starter. Please see the soft starter used manual for reference to configure the remote start as a latch type start. Starter output 1 can also be used to drive a contactor that feeds into the soft starter. See drawing below for a typical soft starter reversal configuration:

Following inputs become available:

<table>
<thead>
<tr>
<th>Inputs</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start &gt;&gt;</td>
<td>Start forward command.</td>
</tr>
<tr>
<td>Start &lt;&lt;</td>
<td>Start reverse command.</td>
</tr>
</tbody>
</table>

Following outputs become available:

<table>
<thead>
<tr>
<th>Outputs</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Starter output 1</td>
<td>Main contactor in series with the soft starter for forward.</td>
</tr>
<tr>
<td>Starter output 2</td>
<td>Main contactor in series with the soft starter for reverse.</td>
</tr>
<tr>
<td>Starter output 3</td>
<td>Remote reset pulse for the soft starter.</td>
</tr>
<tr>
<td>Starter output 4</td>
<td>Remote start output to the soft starter start input.</td>
</tr>
</tbody>
</table>
7.16 Oil Circuit Breaker Direct Online Starter

OCB is used with an OCB contactor. Generally an OCB only has a trip input that accepts a pulse to trip the OCB. But on some OCB a start pulse can be used to reset the OCB trip. See drawing below for a typical OCB configuration:

Following inputs become available:

<table>
<thead>
<tr>
<th>Inputs</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start &gt;&gt;</td>
<td>Start command.</td>
</tr>
</tbody>
</table>

Following outputs become available:

<table>
<thead>
<tr>
<th>Outputs</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Starter output 1</td>
<td>Start pulse of 300ms.</td>
</tr>
<tr>
<td>Starter output 2</td>
<td>Stop pulse of 300ms.</td>
</tr>
</tbody>
</table>
8. NewCode History Log

8.1 Real Time Clock

A 24 hour real time clock has been build into the NewCode. The real time clock has a 1 fared capacitor to keep the real time clock running during power losses. Backup supply from the capacitor will keep the real time clock alive for 1 month. After 1 month the real time clock will reset to 01/01/00 00h00.

The real time clock is used to log faults and events according to the time at the moment a fault or event occurred.

Real time clock date and time can be set on the “Real Time Clock” tab.

8.1 Fault Record

35 last faults get stored in the NewCode. When the fault history becomes full the NewCode just overwrites the oldest fault.

Each fault will also indicate if the fault was triggered by the simulator or if actual fault.

The fault is date and time stamped according to the real time clock of the NewCode.

Running hours is how long the motor was running before the tripped occurred. Running hours is the motor total timed run since the running hours counter was reset not from when the drive started.

Maximum current level percentage is stored.

Minimum voltage phase is stored.
Breaker clear time is the time that it took to clear the fault from the point that the NewCode told the main contactor to trip. This can indicate if the contactor needs to be replaced, as the coil is not discharging properly.

Fault record can be exported to a file. Most spreadsheet viewers like Microsoft Excel can open data file of the fault record. This allows the fault record to be shared by emailing the spreadsheet saved file.

NewCode fault records can be cleared with the aid of the NewCode frontend.

8.2 Event Record

1400 Events get stored in the NewCode according to the NewCode real time clock.

Event records also store the faults but added is the alarm conditions before the trips.

Following events are recorded:
- Setting adjustment on the NewCode.
- Any alarm condition.
- Any trip condition.
- When load is detected. (Start).
- When load goes to zero. (Stop).

On the frontend the last 200 events can be quickly viewed or saved directly to a file. A spreadsheet application like Microsoft Excel can be used to open the file.

Each event indicates if the event was simulated or an actual event.

All alarm and trip flags are indicated with the event.

Running hours is how long the motor was running before the tripped occurred. Running hours is the motor total timed run since the running hours counter was reset not from when the drive started.

Maximum current level percentage is stored.

Minimum voltage phase is stored.
9. Module Configurations

9.1 CT Modules

NewElec offers an array of CT modules that can be selected for different amp ranges. External CBCT will need to be connected to detect earth leakage on the NC 1 to NC 50 models but the NC 100 and NC 300 comes with a built in CBCT.

A ribbon cable is used to connect the CT module to the NewCode. Connection is done by inserting the one side of the ribbon cable at the top of the CT PC plug. The other end is inserted into the PC plug at the bottom of the NewCode.

In order to display the correct amps, kVa and kW the correct model and CT ratio must be selected under the “Settings” tab.

Maximum of 550Vac can be plugged into the CT modules.

*External CBCT should be used if an external CT is used to convert the current. The external CBCT should be connected to the primary side of the external CT’s.*

*Always consider the ribbon cable as live when live line voltage is applied. CT direct voltage measurement is 550Vac maximum.*

The model ranges are:

- FPR0403 – 0.1 to 1 Amp, without CBCT.
- FPR0404 – 0.5 to 5 Amp, without CBCT.
- FPR0405 – 0.25 to 25 Amp, without CBCT.
- FPR0406 – 5 to 50 Amp, without CBCT.
- FPR0402 – 10 to 100 Amps, with CBCT.
- FPR0401 – 30 to 300 Amps, with CBCT.
9.2 1100 to 550 Voltage Converter (FPR0208)

In coming line voltage to the CT modules can only handle a maximum of 550Vac. For higher voltage the 1100 to 550 voltage converter is needed to lower the voltage. This module needs to be wired in series between the line voltage and CT module.

9.3 Insulation Lockout (FPR0420)

Used in conjunction with the insulation protection.

Must be wired below the main contact circuit in order to measure the insulation resistance of the motor. Insulation module can also detect when a cable is being cut through by accident or if the cable is being stolen.

![Warning]

*When used on a feeder panel it is recommended to wire the insulation lockout module brown wire through a normally closed contact that is wired with the main contactor close and open circuit.*
9.4 NewCode Expanded I/O Module (FPR0412)

Adds an additional four outputs and eight differential inputs. TBUS connector is snapped onto the din rail so that Expanded I/O module and NewCode relay can communicate.

Four outputs is relay driven and have the following specifications:
- 250Vac at 6 amps.
- 30Vdc at 6 amps.

Eight inputs are differentially designed which means that different supplies can be wired into the input side. Specifications for the inputs are as follow:
- 24 to 220Vac/dc.

In the front end software under the “Settings” the “Digital Expansion Module Connect” must be checked.

When checking the box other options will open up. Under the “Control Logic” and “Starter Configuration” tab four extra relay outputs can be assigned to flags.

Under the “External modules” tab eight extra inputs delays can be assigned to the inputs.
9.5 RTD Expansion 4 Channel Module (FPR0413)

PT100, PT1000, PTC and NTC thermals can be used on the RTD module. Four channels are provided for reading the temperature of the probes. TBUS connector is snapped onto the Din rail to communicate with the NewCode.

“Settings” tab the RTD must be selected for monitoring the thermal probes. Under the “External modules” the thermal probe type must be selected.

High trip level will trip the NewCode after the temperature is above the set level.
High level warning will set the NewCode warning flag when the temperature is above the set level but will never trip the NewCode relay.
Low level warning will set the NewCode warning flag when the temperature is below the set level but will never trip the NewCode relay.
Low trip level will trip the NewCode after the temperature is below the set level.

Excitation pin must be connected to” –IN “ in a two wire probe. All channels not getting used leave with a 100 ohm resistor and as a PT100.

See the NC-RTD manual for detail usage of the RTD module.
### 9.6 NewCode 4 to 20mA, 2xIn and 2xOut (FPR0415)

Unit provides two 4 to 20mA channels in and out. Each channel also provides loop power to power up the loop. TBUS connector is snapped onto the Din rail to communicate with the NewCode.

“Settings” tab the Analogue channel module must be selected for monitoring and controlling the 4 to 20mA unit. Selecting the analogue module will not trip the relay but will allow the 4 to 20mA unit to be read and controlled.

When analogue input or output is selected then the NewCode will trip on the input or outputs value.

Under the “External modules” the settings are located to setup the analogue modules trips and control.

High trip level will trip the NewCode after the signal is above the set level.

High level warning will set the NewCode warning flag when the signal is above the set level but will never trip the NewCode relay.

Low level warning will set the NewCode warning flag when the signal is below the set level but will never trip the NewCode relay.

Low trip level will trip the NewCode after the signal is below the set level.

Source is the selected signal for the 4 to 20mA out.

High is the highest count for 20mA out.

Low is the lowest count for 0 or 4mA depending on the 4 to 20mA type selected.

ROC is the rate of change that the output must adjust when the source signal changes the value. Zero milliseconds will disable ROC. See the NC-4 to 20mA manual for detail usage of the 4 to 20mA module.
9.7 NewCode MMI 420

Door mounted 4 x 20 character display that allows configuring and monitoring of the NewCode relay. NewCode does not need to be configured to communicate with the MMI-420.

TBUS to RJ converter is used with a RJ11 to RJ11 cable (CAB0100) to establish communication between the NewCode and MMI-420.

The MMI-420 can display all actual values, events, faults and settings.

Seven slots are used to store different settings for panels that connect to more than one type of motor.

Starter controls have also been added to the MMI-420 to allow start and stop commands if the NewCode is configured as a starter.

See the NC-MMI-420 manual for more information on the MMI.

9.8 External Memory Module (FPR0407)

At the end of the TBUS or on the back of the MMI-420 the external module can be mounted.

NewCode writes settings to the external module when settings are changed through the front end, SCADA or MMI-420.

To upload settings to NewCode from the external memory module just press the reset button three times. NewCode will then reset and flash all LED’s as if powering up.

External memory module allows the ease of replacing a NewCode relay without the aid of a laptop or PC.

It is still recommended to save the settings of the NewCode to a file in case the external memory module is lost.
10. Software Configuration Tool (Front end)

PC or laptop can be used to configure the NewCode relay. PC or laptop connects to the relay via the USB port with a mini USB cable or RS232 with the IrDA cable.

10.1 System Requirement

- Window operating system.
- CPU: Pentium II 1 Ghz.
- RAM: 512Mb
- Hard drive space: 50Mb
- CD drive x 2 speed.
- Screen resolution:
  - 1920 x 1080 recommended.
  - 800 x 600 minimum.
- Serial communication.
  - On board RS232 serial port.
  - Or USB to RS232 converter.
    - See manufacturer for driver details on how the drivers should be installed before use.

10.2 Installing Software

After inserting and opening the NewElec product CD in windows explorations window, follow the following steps:

1. Open the directory “NewCode\Configuration Software”.
2. Double click the file “NC Frontend Installation XXX.exe”.
3. Follow the instruction on the screen.
10.3 Installing NewCode USB Drivers

1. Connect the USB cable to the NewCode relay.
2. Windows will ask for the drivers.
3. Select the driver folder “C:\Program Files\NewElec\NewCode\NewCode Drivers”.
4. Ensure that the “Include sub directories” is checked.
5. Press next.
6. Drivers should be installed successfully.

After installing the drivers the port can be found under computer management.

- Right click on “My Computer”.
- Left click on “Manage”.
- Left click on “Device Manager”.
- Expand “Ports” and see if a “(COMX)” is available for use.
10.4 Connecting The Front End To The NewCode

Connect up the Mini USB or IrDA cable to the PC or laptop to the NewCode. IrDA must align with the IrDA port of the NewCode relay.

On the front end select “Options -> Communication”. A communication window will pop up were the port can be selected that the NewCode is connected to.

Press “Connect”. A blue progress bar should run and a popup will show that all settings have been loaded up from the NewCode relay.

10.5 Upload Settings

Settings can be uploaded in two ways:
- Mass upload or,
- Individual upload.

For mass upload press the upload settings button. A popup will indicate that all settings have been uploaded from the NewCode relay.

Each tab has a “Read settings from relay” button that will upload only the selected tab information.
10.6 Download Settings

Settings can be downloaded in two ways:
- Mass download or,
- Individual download.

For mass download press the download settings button. A popup will request which of the settings tab to be downloaded to the NewCode relay.

After pressing the “Ok” is pressed a progress bar will indicate the progress of the download.

Each tab has a “Transmit settings to relay” button that will download only the selected tab information.

10.7 Saving Settings

Saving the settings can be done by selecting “File -> Save Relay Settings” or pressing the save button.

Settings can be loaded again by opening with the front end or opening with notepad.

Settings can be edited with the aid of notepad.

A NewCode does not need to be connected to create a settings file.

10.8 Loading Settings

Loading settings can be done by selecting “File -> Open Relay Setting” or pressing the open button.

After the settings file is opened then the settings can be downloaded or edited and downloaded to the NewCode relay.
10.9 Printing Settings

Printing can be done by selecting “File -> Print” or by pressing the print button 📄.

NewCode settings take four A4 sheets to be printed on so double sided printing is recommended to save paper. Also think before you print.

10.10 Fault Record, View, Save And Erase

Can be uploaded under the “Fault History” tab. When the NewCode relay is connected press the “Upload faults from relay” button. A progress bar will indicate the progress of uploading the faults.

<table>
<thead>
<tr>
<th>Actual</th>
<th>Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Update faults from relay</td>
<td></td>
</tr>
</tbody>
</table>

Do not go to other tabs as this will cancel the uploading process.

By pressing the “Save fault record on disk” button under the “Fault History” tab will save the faults to a spreadsheet file that can be viewed with a spreadsheet application.

Pressing the “Clear fault history in relay” button under “Fault History” tab will erase the fault history on the NewCode relay. Event records will still contain the faults. Faults in the event records cannot be erased.
10.11 Event Record, View And Save

Events can be accessed under the “Event History” tab. Events can be viewed in two ways. A quick view that will show the last 200 records in the front end or save all 1400 to a spreadsheet file.

Quick view can be done by pressing the “Upload last 200 or less” button.

The grid below the button will be populated with events from the NewCode relay. These events that have been uploaded cannot be saved to a file later.

Saving the events can be done by pressing the “Start uploading of records to disc file”. A progress bar will indicate the progress of uploading the events and saving the events into a spreadsheet document.

Do not change tabs while uploading events as it can cancel the uploading of events.

10.12 Recording

“Recorder” can be used to record the actual data from the NewCode to a file. Recording file can be opened with a spreadsheet application in order to view the recording data.

To record press the “Property” button.
Under the "Control" tab select the "File I/O" tab.

Select the directory and the file name that must be used for recording by pressing the "..." button next to the file name.

When ready press the "Activate" button the recorder will start recording to the selected file. Stopping the recording by press the "Deactivate" button. The file can be imported later with a spreadsheet program.
### 10.13 Simulator

In order to use the simulator a NewCode must be connected with the modules to be used by simulation.

Simulator can force the NewCode into believing that an actual system is being run. The tool is useful for testing if a SCADA system is using the load, voltage and so on correctly.
10.14 Upgrading Firmware

Upgrading the firmware of the NewCode if a newer firmware revision is available.

Always make sure a copy of the current firmware is loaded onto the system, so that downgrading can be possible if the update of the relay causes any problems.

- Bootloader can be found on the startup menu Program Files -> NewElec -> NewCode -> NewCode bootloader.
- Make sure that the correct comport is selected and that the port is open. If the port is not opened then press the “Open Port” button.
- Press the “find device” button to find the NC-Relay. You will see the dialog box displaying the NC-Relay current revision.

- Open up the new encoding file with the “Open file” button.
- If the file was successfully opened that the “Program device” button will be enabled.

- Press the “Program device” button.
After programming is complete press the "Close Port" button and then close the bootloader frontend. This will prevent the frontend to take you back to the bootloader frontend.

Close the bootloader frontend and open up the NewCode frontend.

10.15 Uninstalling

In order to install a newer version of the frontend the old frontend needs to be uninstalled. All saved files will not be removed and remains in the directory.

Uninstall button can be found at Program Files -> NewElec -> NewCode -> Uninstall.

Press "Yes" and wait for the uninstall to finish.
11. Communication

Two types of SCADA communication protocols are available. Under the “Comms + Statistics” the communication settings can be found.

11.1 Profibus DP

The DP address can be set from 1 to 126.

Two types of GSD files can be selected.
- NEWEF877 – Make it possible to replace a MA-Relay with a NewCode.

The Profibus module has been certified at the Netherlands through PROCENTEC certification number Z01714.

NEWEF877 is configured as per the MA-PROFI-BBRTU module. The configuration is only meant for DPV0.

NEWEF880 is a DPV0 and DPV1 configuration that can be used.

See the “NC-MK1-PROFIBUS-DP1 Manual XXX.pdf” manual for configuring the Profibus.
11.2 Modbus RTU

<table>
<thead>
<tr>
<th>Communication Settings</th>
<th>Modbus Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Protocol:</td>
<td>Cyclic Time</td>
</tr>
<tr>
<td>Address:</td>
<td>0.5 Sec</td>
</tr>
<tr>
<td>Baud Rate:</td>
<td>Longest Cycle Time</td>
</tr>
<tr>
<td>19.2 bps</td>
<td>0.5 Sec</td>
</tr>
<tr>
<td>Timeout:</td>
<td>Listen Mode</td>
</tr>
<tr>
<td>10 Sec</td>
<td>Disabled</td>
</tr>
<tr>
<td></td>
<td>Message Counter</td>
</tr>
<tr>
<td></td>
<td>CRC Counter</td>
</tr>
<tr>
<td></td>
<td>Revision</td>
</tr>
</tbody>
</table>

Modbus module address can be set from 1 to 255.

Baud rates supported:
- 2400 bps
- 4800 bps
- 9600 bps
- 19200 bps
- 38400 bps
- 57600 bps

Time out allows when not receiving a message from the Modbus master to clear the PLC byte after the set timeout time.
# 12. Definitions and Terminology

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Apparent power consumption</td>
<td>It is the amount of energy consumed. The power factor is not taken into account and is measured in kV.A.h</td>
</tr>
<tr>
<td>Apparent power dissipation</td>
<td>It is the product of voltage and current. The power is excluded and it is measured in kV.A.</td>
</tr>
<tr>
<td>Breaker clearance time</td>
<td>It is the time taken by the breaker to clear the fault by interrupting the supply current to the motor. It can be seen as breaker response time and is useful information for breaker maintenance.</td>
</tr>
<tr>
<td>Consecutive starts</td>
<td>The amount of starts allowed during a time interval created by the starts per hour setting. (See also starts per hour)</td>
</tr>
<tr>
<td>Core balance current transformer</td>
<td>A current transformer used to detected possible current leakage to earth from one or more of the phases. (Earth leakage detection)</td>
</tr>
<tr>
<td>Digital field input</td>
<td>A signal generated by an external switch that could have an effect on the relay operation depending on the logic configuration.</td>
</tr>
<tr>
<td>Earth fault</td>
<td>It is leakage current above 2 amps and a severe form of an earth leakage condition. (See also core balance current transformer)</td>
</tr>
<tr>
<td>Earth leakage fault</td>
<td>It is leakage current up to 2 amps exceeding a trip level setting. (See also core balance current transformer)</td>
</tr>
<tr>
<td>Full load current</td>
<td>Current drawn by the motor at full load operation (90% to 100%)</td>
</tr>
<tr>
<td>Fundamental harmonic frequency</td>
<td>50Hz in South Africa and 60Hz elsewhere.</td>
</tr>
<tr>
<td>In Service state</td>
<td>Phase current above 10% of full load current</td>
</tr>
<tr>
<td>Isolation lockout / Insulation failure</td>
<td>The insulation resistance of the motor is measured while in a static (not in service) condition. If the resistance drops below 20 kOhm the relay will trip and will prevent a start.</td>
</tr>
<tr>
<td>Motor full load setting (MLC)</td>
<td>Adjustment of the relay current sensitivity. This is where the current level measurement is adjusted to read just below 100% when the motor operates at full load.</td>
</tr>
<tr>
<td>Non volatile memory</td>
<td>It is memory that will maintain data even when power is switched off for long periods. (see also volatile memory)</td>
</tr>
<tr>
<td>Over current (Overload)</td>
<td>Current level above 100% of full load current</td>
</tr>
<tr>
<td>Phase rotation</td>
<td>Normal phase rotation sequence is red, white and blue. Reverse rotation sequence is blue, white and red.</td>
</tr>
</tbody>
</table>
| Power factor                     | It is die relationship between real power and apparent power Power factor %  = ((V x I x CosØ) / (V x I)) x 100%  
                                  |  
                                  | Power factor = CosØ                                                                                                                             |
| Real power consumption           | It is the amount of energy consumed. The power factor is taken into account and is measured in kWatt.h                                                                                                   |
| Real power dissipation           | It is the product of voltage and current. The power factor is included and it is measured kWatt.                                                                                                       |
### Run-Stall
The motor went through the normal start procedure and the current level return to normal full level. If the rotor jam and the current rise above the stall setting (110% to 300%) it is recognized as a Run-Stall fault condition.

### Running hours
The amount of time the motor was in an in-service state.

### Starts per hour
Starts per hour define the time interval in which a restricted amount of starts are allowed. (See also consecutive starts)

### Thermal capacity
It is a temperature related quantity expressed in percentage, which also takes in consideration the physical size, mass, construction, type of material etcetera used of the motor. It is normally indicated as capacity used unless otherwise stated.

### Thermal curve class
It is the thermal curve derived from the unitary (one second) thermal curve. It is also the curve that goes through the points where maximum lock rotor current and maximum lock rotor time of the particular motor is specified.

### Total Harmonic Distortion
Two standards are used:

\[
\text{THD} = \sum_{n=1}^\infty \frac{I_n}{I_1} \times 100\%
\]

### Undercurrent (Minimum load)
Current level when motor run at no load condition.

### Vectorial-Stall
It is detected during the startup procedure of the motor. A motor normally startup with a bad power factor and gradually improve it as full speed is approached. If no power factor improvement is detected for longer then 33% of the curve class time the motor is tripped to prevent thermal and mechanical damage.

### Volatile memory
It is memory that will loose data during a power supply interruption. (see also non volatile memory)
13. Thermal Curves of the NewCode Relay

NewCode Thermal Trip Curve

Trip Time Delay (Seconds) vs. Multiples of Full Load Current Setting

- Class 40
- Class 35
- Class 30
- Class 25
- Class 20
- Class 15
- Class 10
- Class 5
- Class 3
- Class 1
14. Diagrams

14.2 Expanded IO module wiring diagram of the Relay.

TBUS NewCode Rack Expansion Connector

NewCode Protection EXPANDED I/O
(FPR 0412)

* Powered from NewCode relay.
14.3 RTD Module Wiring Diagram

**NewCode Protection**
4 Channel RTD Module

**NC-RTD-04**
(FPR 0413)

* Powered from NewCode relay.
14.4 4 to 20mA Module Wiring Diagram

**NC-420-02-02**

- Loop powered example
- Self powered example
- NewCode Protection
- 2 x 4 to 20mA I/O Module

![Diagram of 4 to 20mA Module Wiring](image-url)
15. Part Numbers

<table>
<thead>
<tr>
<th>NewElec NewCode Ordering Information</th>
<th>Part No</th>
<th>Bin No.</th>
</tr>
</thead>
<tbody>
<tr>
<td>NewCode Motor Protection Relay with Profibus</td>
<td>FPR0400</td>
<td></td>
</tr>
<tr>
<td>NewCode Motor Protection Relay with Modbus</td>
<td>FPR0418</td>
<td></td>
</tr>
<tr>
<td>30 - 300 Amp C.T. &amp; Core Balance with 110 – 550V Converter</td>
<td>FPR0401</td>
<td></td>
</tr>
<tr>
<td>10 – 100 Amp C.T. &amp; Core Balance with 110 – 550V Converter</td>
<td>FPR0402</td>
<td></td>
</tr>
<tr>
<td>0.1 – 1 Amp C.T. Block with 110 – 550V Converter</td>
<td>FPR0403</td>
<td></td>
</tr>
<tr>
<td>0.5 – 5 Amp C.T. Block with 110 – 550V Converter</td>
<td>FPR0404</td>
<td></td>
</tr>
<tr>
<td>0.25 – 25 Amp C.T. Block with 110 – 550V Converter</td>
<td>FPR0405</td>
<td></td>
</tr>
<tr>
<td>5 – 50 Amp C.T. Block with 110 – 550V Converter</td>
<td>FPR0406</td>
<td></td>
</tr>
<tr>
<td>Core Balance - 100mm Dia. Window</td>
<td>BTX0010</td>
<td></td>
</tr>
<tr>
<td>Connection Cable – 1000mm – C.T. to Relay</td>
<td>FPR0408</td>
<td></td>
</tr>
<tr>
<td>Connection Cable – 500mm – C.T. to Relay</td>
<td>FPR0409</td>
<td></td>
</tr>
<tr>
<td>Connection Cable – 300mm – C.T. to Relay</td>
<td>FPR0410</td>
<td></td>
</tr>
<tr>
<td>Connection Cable – 100mm – C.T. to Relay</td>
<td>FPR0411</td>
<td></td>
</tr>
<tr>
<td>External Memory Module</td>
<td>FPR0407</td>
<td></td>
</tr>
<tr>
<td>NewCode Expanded I/O Module – 8 In/4 Out</td>
<td>FPR0412</td>
<td></td>
</tr>
<tr>
<td>RTD Expansion Module</td>
<td>FPR0413</td>
<td></td>
</tr>
<tr>
<td>NewCode Insulation Lockout Module</td>
<td>FPR0420</td>
<td></td>
</tr>
<tr>
<td>NC-MK1-420-02-02 2X40-20 mA Input/Output</td>
<td>FPR0415</td>
<td></td>
</tr>
<tr>
<td>NC-MK1-MMI-420</td>
<td>FPR0414</td>
<td></td>
</tr>
<tr>
<td>NC-MK1-MMI-420 with remote inputs</td>
<td>FPR0432</td>
<td></td>
</tr>
</tbody>
</table>